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PEMANFAATAN SISTEM PENGENDALI WATER LEVEL 

CONTROL UNTUK BUDIDAYA IKAN GURAME  

PADA KOLAM TERPAL MENGGUNAKAN LOGIKA 

FUZZY BERBASIS MIKROKONTROLER 

 

 

ABSTRAK 

 

Teknologi otomatisasi  sistem kendali dan mikrokontroler merupakan 

salah satu cara yang digunakan untuk mendeteksi kondisi air dan ketinggian 

air serta sistem untuk mengendalikan pompa air secara otomatis. Adapun 

proses otomatisasi dalam pengatur ketinggian air ini sangat penting agar dapat 

menghemat kebutuhan air pada kolam ikan. Dalam penelitian ini dibuatlah 

teknologi otomatisasi menggunakan logika fuzzy berbasis mikrokontroler, 

untuk sistem pendeteksi kondisi air dan ketinggian air serta sistem untuk 

mengendalikan pompa air, yang dapat diatur secara otomatis sesuai batas atas 

(maximal) dan batas bawah (minimal) serta dapat melakukan penggantian air 

kolam secara otomatis apabila air kolam sudah keruh.  

 

Kata Kunci : Air, logika fuzzy, Mikrokontroler 
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UTILIZATION OF WATER LEVEL CONTROL SYSTEM 

FOR GURAME FISH CULTIVATION 

IN THERMAL POOL USING MICROCONTROLLER 

FUZZY LOGIC 

 

 
ABSTRACT 

Control system automation technology and microcontroller is one way 

that is used to detect water conditions and water levels as well as a system to 

automatically control a water pump. The process of automation in regulating 

water levels is very important in order to save water requirements in fish ponds. 

In this study, automation technology was made using microcontroller-based 

fuzzy logic, for a system of detecting water conditions and water levels and a 

system for controlling water pumps, which can be adjusted automatically 

according to the upper limit (maximal) and lower limit (minimum) and can 

replace pool water automatically when the pool water is cloudy. 

 

Keywords: Water, fuzzy logic, microcontroller 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



v 
 

KATA PENGANTAR 

 بسم الله الرحمن الرحيم
Segala puji bagi Allah SWT pemilik singgasana kerajaan langit dan bumi yang 

senantiasa memberikan taburan rahmat dan karunia-NYA sehingga penulis dapat 

menyelesaikan penulisan buku ini dengan judul : “Pemanfaatan Sistem 

Pengendali Water Level Control Untuk Budidaya Ikan Gurame Pada 

Kolam Terpal Menggunakan Logika Fuzzy Berbasis Mikrokontroler”. 

Sholawat dan salam senantiasa tercurah kepada Muhammad SAW beserta kerabat, 

sahabat, para pengikutnya sampai akhir zaman, adalah sosok yang telah membawa 

manusia dari alam yang penuh kegelapan kedalam cahaya keimanan sehingga kita 

menjadi manusia beriman, berilmu, dan tetap beramal shaleh agar menjadi manusia 

yang berakhlak mulia. 

Penulisan buku ini bertujuan untuk melengkapi persyaratan luaran penelitian. 

Buku ini juga diharapkan dapat menambah wawasan ilmu pengetahuan, khususnya 

bidang ilmu komputer dalam instalasi nilai-nilai Islam yang terpadu dalam proses 

pembelajaran di lingkungan Universitas Islam Negeri Sumatera Utara. 

Dalam penulisan buku ini, saya sangat menyadari bahwa masih banyak 

kekurangan yang perlu perbaikan di sana sini, sumbangan pemikiran yang 

membangun sangat penulis harapkan dari rekan-rekan sejawat terutama dari dosen-

dosen senior. Juga usulan dari para pengguna buku ini terutama mahasiswa Ilmu 

Komputer, semoga konten buku ini dapat diperkaya melalui evaluasi terus menerus. 

Atas segala budi baik yang telah penulis terima dari semua pihak untuk itu saya 

ucapkan ribuan terima kasih. Semoga Allah SWT membalas kebaikan seluruh rekan 

sekalian dengan ganjaran yang berlipat ganda, Amiin. 

Medan,       Oktober 2018 

Penulis 

 

 

 

Sriani, M.Kom 

NIDN. 0103078405 



vi 
 

DAFTAR ISI 

LEMBAR PENGESAHAN .............................................................................. i 

SURAT PERNYATAAN BEBAS PLAGIASI ........................................... ii 

ABSTRAK...................................................................................................... iii 

ABSTRACT ................................................................................................... iv 

KATA PENGANTAR ..................................................................................... v 

DAFTAR ISI .................................................................................................. vi 

DAFTAR GAMBAR .................................................................................... viii 

DAFTAR TABEL ........................................................................................... x 

BAB I ............................................................................................................... 1 

PENDAHULUAN ........................................................................................... 1 

1.1. Latar Belakang .................................................................................. 1 

1.2. Rumusan Masalah ............................................................................. 2 

1.3. Tujuan ............................................................................................... 3 

1.4. Signifikansi ....................................................................................... 3 

BAB II ............................................................................................................. 4 

TINJAUAN PUSTAKA .................................................................................. 4 

2.1. Definisi Prototype ............................................................................. 4 

2.2. Mikrokontroller ................................................................................. 5 

2.2.1. Fitur AVR ATMega 328............................................................ 7 

2.3. Komponen Elektronika ................................................................... 10 

2.3.1. Resistor .................................................................................... 10 

2.3.2. LED (Light Emitting Diode) ................................................... 12 

2.3.3. Transformator .......................................................................... 13 

2.3.4. Kapasitor .................................................................................. 14 

2.3.5. Transistor ................................................................................. 16 

2.3.6. Dioda ....................................................................................... 17 



vii 
 

2.4. Relay ............................................................................................... 18 

2.5. Sensor Ultrasonik ............................................................................ 20 

2.6. Turbidity Sensor.............................................................................. 21 

2.7. Fuzzy Logic ..................................................................................... 21 

2.7.1 Himpunan Fuzzy (Fuzzy Set) ........................................................ 22 

2.7.2 Jenis-Jenis Fungsi Keanggotaan ................................................... 24 

2.8. Flowchart ........................................................................................ 24 

2.9. Arduino Development Environment ............................................... 26 

BAB III .......................................................................................................... 29 

METODE PENELITIAN .............................................................................. 29 

3.1. Jenis Penelitian................................................................................ 29 

3.2. Analisa Kebutuhan Sistem .............................................................. 30 

3.3. Pemodelan dan Perancangan Sistem ............................................... 30 

3.4. Testing Prototype Sistem ................................................................ 30 

BAB IV .......................................................................................................... 32 

HASIL DAN PEMBAHASAN ..................................................................... 32 

4.1. Arsitektur Sistem ............................................................................ 32 

4.2. Kebutuhan Alat ............................................................................... 33 

4.3. Perancangan Fuzzy .......................................................................... 34 

4.4. Hasil Penelitian ............................................................................... 39 

4.5. Analisis Sistem................................................................................ 45 

BAB V ........................................................................................................... 46 

PENUTUP ..................................................................................................... 46 

Kesimpulan ................................................................................................ 46 

DAFTAR REFERENSI ................................................................................. 48 

CODE ARDUINO ......................................................................................... 50 

 

  



viii 
 

DAFTAR GAMBAR 

Gambar 2.1 Arsitektur ATMega 328 ............................................................... 9 

Gambar 2.2 Konfigurasi Pin ATMega 328 ..................................................... 9 

Gambar 2.3 Simbol Resistor .......................................................................... 11 

Gambar 2.4 Resistor ...................................................................................... 11 

Gambar 2.5 Simbol LED ............................................................................... 12 

Gambar 2.6 Bentuk Fisik Resistor ................................................................. 13 

Gambar 2.7 Fluks Pada Transformator.......................................................... 14 

Gambar 2.8 Bentuk Fisik Kapasitor .............................................................. 15 

Gambar 2.9 Symbol Transistor ...................................................................... 17 

Gambar 2.10 Simbol Dioda ........................................................................... 18 

Gambar 2.11 Sensor Ultrasonik..................................................................... 20 

Gambar 2.12 Turbidity Sensor ...................................................................... 21 

Gambar 2.13 Interface Arduino IDE ............................................................. 27 

Gambar 4.1 Arsitektur Sistem Water Level Control ..................................... 32 

Gambar 4.2 Flowchart Kinerja Sistem Water Level Control ........................ 35 

Gambar 4.3 Lanjutan Flowchart Kinerja Sistem Water Level Control ......... 36 

Gambar 4.4 Fungsi Keanggotaan Ketinggian Air ......................................... 38 

Gambar 4.5 Fungsi Keanggotaan Kekeruhan Air ......................................... 38 

Gambar 4.1 Perancangan Prototype Sistem Pengatur Ketinggian Air .......... 39 

Gambar 4.2 Persiapan Uji Coba .................................................................... 40 

Gambar 4.2 Prototype Tangki Air ................................................................. 40 

Gambar 4.3 Prototype Kolam Ikan yang dilengkapi dengan Ultrasonik dan 

Turbidty Sensor ............................................................................................. 41 

Gambar 4.4 Prototype Kolam Ikan Dilengkapi Keran Valve Untuk 

Membuang Air Keruh .................................................................................... 42 

Gambar 4.5 Uji Coba Alat ............................................................................. 43 



ix 
 

Gambar 4.6 Pengujian Sistem Pengendali Water Level Control Untuk 

Budidaya Ikan Gurame Pada Kolam Terpal Menggunakan Logika Fuzzy 

Berbasis Mikrokontroler ................................................................................ 44 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  



x 
 

DAFTAR TABEL 

Tabel 2.1 Kode Warna Resistor ..................................................................... 11 

Table 2.2 Simbol Flowchart .......................................................................... 25 

Tabel 4.1 Kebutuhan Alat .............................................................................. 33 

 

 

 

 

 

 

 

 



 

1 
 

BAB I 

PENDAHULUAN 

 

1.1. Latar Belakang 

Seiring berkembangnya teknologi otomatisasi sistem kendali dan 

mikrokontroler, berbagai alat yang praktis dan efisien telah banyak diciptakan. 

Tujuan pembuatan berbagai alat tersebut yaitu untuk memenuhi kebutuhan 

manusia dalam kehidupan sehari-hari, sehingga dapat dimanfaatkan untuk 

mempermudah rutinitas yang dilakukan manusia secara umum diera modern 

seperti saat ini. Untuk menunjang hal tersebut perlu didukung adanya sarana 

maupun prasarana yang disesuaikan dengan perkembangan teknologi yang 

ada. Penghematan energi menjadi hal yang sangat penting bagi kehidupan 

manusia saat ini. Salah satu energi yang memegang peranan dalam kehidupan 

kita sehari-hari adalah air. Air memegang peranan yang sangat penting dalam 

kehidupan manusia. Peran tersebut dapat terlihat dari tingkat kebutuhan 

manusia dalam kegiatan sehari-harinya. Sebagai salah satu contoh, saat ini 

tingkat kebutuhan air semakin tinggi seiring dengan semakin tingginya tingkat 

pertambahan penduduk dunia. 

Penggunaan air pada kolam ikan harus dikondisikan seefektif mungkin, 

agar dapat dilakukan proses penggantian air yang tepat. Artinya air kolam ikan 

diganti apabila kondisinya sudah keruh, sehingga tidak akan membuang-buang 

air yang kondisinya masih bersih. Oleh karena itu, diperlukan suatu cara agar 

bisa memantau dan mengatur level volume air dalam kolam dan mengatur 

penggantian air kolam secara otomatis, serta sistem yang dapat mengendalikan 

pompa secara otomatis untuk mengalirkan air kedalam bak kolam ikan 

tersebut.  
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Dalam penelitian ini dibuatlah teknologi otomatisasi untuk sistem 

pendeteksi kondisi air dan ketinggian air serta sistem untuk mengendalikan 

pompa air, yang dapat diatur secara otomatis sesuai batas atas (maximal) dan 

batas bawah (minimal) serta dapat melakukan penggantian air kolam secara 

otomatis apabila air kolam sudah keruh.  

Berdasarkan hal tersebut diatas maka dibuatlah sebuah penelitian 

dengan judul : Pemanfaatan Sistem Pengendali Water Level Control 

Untuk Budidaya Ikan Gurame Pada Kolam Terpal Menggunakan Logika 

Fuzzy Berbasis Mikrokontroler. Teknologi yang dikembangkan pada 

penelitian ini, diharapkan mempunyai beberapa manfaat dan keunggulan yaitu 

mengatasi permasalahan dalam mendeteksi kondisi air dan ketinggian air serta 

sistem untuk mengendalikan pompa air. Dimana sistem ini dapat secara 

otomatis mengisi bak kolam ikan dan mengendalikan pompa air. Dengan 

adanya sistem otomatis pengendali level air ini, seseorang tidak perlu lagi 

meluangkan waktu dan tenaganya untuk mengawasi level air pada bak kola 

mikan. 

 

1.2. Rumusan Masalah 

Adapun yang menjadi perumusan masalah dalam membangun sistem ini 

adalah: 

1. Bagaimana merancang sistem pendeteksi kondisi air dan ketinggian air 

serta sistem untuk mengendalikan pompa air secara otomatis berbasis 

mikrokontroler? 

2. Bagaimana mikrokontroler mampu menghidupkan pompa air dan 

mengisi bak kolam ikan mencapai batas tertentu? 

3. Bagaimana mikrokontroller mampu mematikan pompa air dan 

menghentikan pengisian bak kolam mikan pada saat volume air pada 

bak kolam mencapai batas tertentu? 
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1.3. Tujuan  

Adapun yang menjadi tujuan peneliti dalam membangun sistem water 

level control adalah sebagai berikut: 

1. Merancang sistem pendeteksi kondisi air dan ketinggian air serta sistem 

untuk mengendalikan pompa air. 

2. Mengatasi kemungkinan terjadinya tumpahan air dari bak kolam ikan. 

3. Mengatasi kemungkinan terjadinya kekosongan air pada bak kolam. 

4. Memanfaatkan mikrokontroler sebagai suatu sarana pendeteksi kondisi 

air dan ketinggian air serta sistem untuk mengendalikan pompa air. 

 

1.4. Signifikansi 

Adapun beberapa manfaat yang diharapkan dapat terealisasi dengan 

Sistem Pengendali Water Level Control adalah : 

1. Menciptakan sarana pengendali level air sehingga pemanfaatan air 

dapat lebih efisien. 

2. Mengoptimalkan fungsi mikrokontroler dalam menunjang kegiatan 

sehari-hari baik perorangan maupun masyarakat umum. 
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BAB II 

TINJAUAN PUSTAKA 

 

2.1. Definisi Prototype 

 

1Menurut Raymond McLeod, prototype didefinisikan sebagai alat yang 

memberikan ide bagi pembuat maupun pemakai potensial tentang cara system 

berfungsi dalam bentuk lengkapnya, dan proses untuk menghasilkan sebuah 

prototype sisebut prototyping.  

Ada 2 jenis prototype, antara lain: 

1. Evolutionary prototype 

Evolutionary prototype akan terus-menerus disempurnakan hingga 

mempunyai semua fungsi yang dibutuhkan user dari sistem yang baru. 

Kemudian barulah pembuatannya dilanjutkan. Jadi, evolutionary prototype 

nantinya akan menjadi sistem yang sesungguhnya. 

 

2. Requirements prototype 

Requirements prototype dikembangkan sebagai suatu cara untuk 

menentukan kebutuhan fungsional dari sistem yang baru ketika user tidak 

bisa menyampaikan secara eksplisit apa yang mereka inginkan. Dengan 

meninjau kembali requirements prototype selagi fitur-fitur ditambahkan, 

user bisa menetapkan proses yang dibutuhkan untuk sistem baru tersebut. 

Ketika  semua  kebutuhannya  terpenuhi, requirements  prototype sudah 

mencapai tujuannya dan proyek lain akan dibangun untuk mengembangkan 

                                                 
1 http://awaysidik.blogspot.com/2013/07/metode-prototyping-menurut-raymond.html 
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sistem baru tersebut. Jadi, requirements prototype tidak akan menjadi 

sistem yang sesungguhnya. 

Keuntungan yang didapatkan dengan menggunakan pendekatan 

prototyping, antara lain: 

1. Memperlancar komunikasi antara pengembang dengan user. 

2. Pengembang menjadi lebih jeli dalam menentukan kebutuhan user. 

3. User memegang peran yang lebih aktif dalam pengembangan sistem. 

4. Pengembang dan user menghabiskan lebih sedikit waktu dan usaha 

dalam mengembangkan sistem. 

5. Implementasi menjadi lebih mudah karena user telah mengetahui apa 

yang diharapkan. 

Sedangkan kelemahan yang memungkinkan untuk terjadi dengan 

menggunakan pendekatan prototyping adalah: 

1. Sikap terlalu tergesa-gesa dalam membuat prototype bisa menyebabkan 

diambilnya jalan pintas dalam pendefinisian masalah, evaluasi 

alternatif, dan dokumentasi. Hal ini menghasilkan usaha yang cepat 

namun tidak akurat lagi. 

2. User bisa menjadi terlalu bersemangat dengan prototype, yang 

mengarah ke ekspektasi yang tidak realistik terhadap pengembangan 

sistem. 

3. Computer-human interface yang disediakan alat prototype tertentu 

tidak mencerminkan teknik perancangan yang baik. 

2.2.  Mikrokontroller 

2Mikrokontroler adalah dalah sistem mikroprosesor lengkap yang 

terkandung di dalam sebuah chip. Mikrokontroler berbeda dari mikroprosesor 

                                                 
2 https://id.wikipedia.org/wiki/Pengendali_mikro#Mikrokontroler_berdasarkan_arsitekturnya 



 

6 
 

serba guna yang digunakan dalam sebuah PC, karena di dalam sebuah 

mikrokontroler umumnya juga telah berisi komponen pendukung sistem 

minimal mikroprosesor, yakni memori dan antarmuka I/O, sedangkan di 

dalam mikroprosesor umumnya hanya berisi CPU saja. 

Dengan kata lain, mikrokontroler adalah suatu alat elektronika digital 

yang mempunyai masukan dan keluaran serta kendali dengan program yang 

bisa ditulis dan dihapus dengan cara khusus, cara kerja mikrokontroler 

sebenarnya membaca dan menulis data. Sekedar contoh, bayangkan diri Anda 

saat mulai belajar membaca dan menulis, ketika Anda sudah bisa melakukan 

hal itu Anda bisa membaca tulisan apapun baik buku, cerpen, artikel dan 

sebagainya, dan Andapun bisa pula menulis hal-hal sebaliknya. Begitu pula 

jika Anda sudah mahir membaca dan menulis data maka Anda dapat membuat 

program untuk membuat suatu sistem pengaturan otomatik menggunakan 

mikrokontroler sesuai keinginan Anda.  

Mikrokontroler merupakan komputer didalam chip yang digunakan 

untuk mengontrol peralatan elektronik, yang menekankan efisiensi dan 

efektifitas biaya. Secara harfiahnya bisa disebut “pengendali kecil” dimana 

sebuah sistem elektronik yang sebelumnya banyak memerlukan komponen-

komponen pendukung seperti IC TTL dan CMOS dapat direduksi/diperkecil 

dan akhirnya terpusat serta dikendalikan oleh mikrokontroler ini.  

Mikrokonktroler digunakan dalam produk dan alat yang dikendalikan 

secara automatis, seperti sistem kontrol mesin, remote controls, mesin kantor, 

peralatan rumah tangga, alat berat, dan mainan. Dengan mengurangi ukuran, 

biaya, dan konsumsi tenaga dibandingkan dengan mendesain menggunakan 

mikroprosesor memori, dan alat input output yang terpisah, kehadiran 

mikrokontroler membuat kontrol elektrik untuk berbagai proses menjadi lebih 

ekonomis. Dengan penggunaan mikrokontroler ini maka :  
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1. Sistem elektronik akan menjadi lebih ringkas  

2. Rancang bangun sistem elektronik akan lebih cepat karena sebagian besar 

dari sistem adalah perangkat lunak yang mudah dimodifikasi  

3. Pencarian gangguan lebih mudah ditelusuri karena sistemnya yang 

kompak  

Agar sebuah mikrokontroler dapat berfungsi, maka mikrokontroler 

tersebut memerlukan komponen eksternal yang kemudian disebut dengan 

sistem minimum. Untuk membuat sistem minimal paling tidak dibutuhkan 

sistem clock dan reset, walaupun pada beberapa mikrokontroler sudah 

menyediakan sistem clock internal, sehingga tanpa rangkaian eksternal pun 

mikrokontroler sudah beroperasi. 

Yang dimaksud dengan sistem minimal adalah sebuah rangkaian 

mikrokontroler yang sudah dapat digunakan untuk menjalankan sebuah 

aplikasi. Sebuah IC mikrokontroler tidakakan berarti bila hanya berdiri sendiri. 

Pada dasarnya sebuah sistem minimal mikrokontroler AVR memiliki prinsip 

yang sama. 

2.2.1.  Fitur AVR ATMega 328 

3ATMega328 adalah ATmega328 adalah mikrokontroler chip tunggal 

yang dibuat oleh Atmel dalam keluarga megaAVR (kemudian Microchip 

Technology mengakuisisi Atmel pada tahun 2016) dan  ATmega328 memiliki 

arsitektur Harvard yang dimodifikasi 8-bit RISC prosesor inti. 

Mikrokontroller ini memiliki beberapa fitur antara lain: 

1. 130 macam instruksi yang hampir semuanya dieksekusi dalam satu siklus 

clock.  

                                                 
3 https://en.wikipedia.org/wiki/ATmega328 
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2. 32 x 8-bit register serba guna.  

3. Kecepatan mencapai 16 MIPS dengan clock 16 MHz.  

4. 32 KB Flash memory dan pada arduino memiliki bootloader yang 

menggunakan 2 KB dari flash memori sebagai bootloader.  

5. Memiliki EEPROM (Electrically Erasable Programmable Read Only 

Memory) sebesar 1KB sebagai tempat penyimpanan data semi permanent 

karena EEPROM tetap dapat menyimpan data meskipun catu daya 

dimatikan.  

6. Memiliki SRAM (Static Random Access Memory) sebesar 2KB.  

7. Memiliki pin I/O digital sebanyak 14 pin 6 diantaranya PWM (Pulse Width 

Modulation) output.  

8. Master / Slave SPI Serial interface.  

Mikrokontroller ATmega 328 memiliki arsitektur Harvard, yaitu 

memisahkan memori untuk kode program dan memori untuk data sehingga 

dapat memaksimalkan kerja dan parallelism. Instruksi – instruksi dalam 

memori program dieksekusi dalam satu alur tunggal, dimana pada saat satu 

instruksi dikerjakan instruksi berikutnya sudah diambil dari memori program. 

Konsep inilah yang memungkinkan instruksi – instruksi dapat dieksekusi 

dalam setiap satu siklus clock. 32 x 8-bit register serba guna digunakan untuk 

mendukung operasi pada ALU ( Arithmatic Logic unit ) yang dapat dilakukan 

dalam satu siklus. 6 dari register serbaguna ini dapat digunakan sebagai 3 buah 

register pointer 16-bit pada mode pengalamatan tidak langsung untuk 

mengambil data pada ruang memori data.  

Ketiga register pointer 16-bit ini disebut dengan register X ( gabungan 

R26 dan R27 ), register Y ( gabungan R28 dan R29 ), dan register Z ( gabungan 

R30 dan R31 ). Hampir semua instruksi AVR memiliki format 16-bit. Setiap 

alamat memori program terdiri dari instruksi 16-bit atau 32-bit.  
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Selain register serba guna di atas, terdapat register lain yang terpetakan 

dengan teknik memory mapped I/O selebar 64 byte. Beberapa register ini 

digunakan untuk fungsi khusus antara lain sebagai register control Timer/ 

Counter, Interupsi, ADC, USART, SPI, EEPROM, dan fungsi I/O lainnya. 

Register – register ini menempati memori pada alamat 0x20h – 0x5Fh. 

 

Gambar 2.1 Arsitektur ATMega 328 

Sumber: (http://ramdhon-interface.blogspot.com/2014/10/atmega328-

diagram-blok.html, 2012) 

 

Gambar 2.2 Konfigurasi Pin ATMega 328 
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(http://ym-try.blogspot.com/2014/02/atmega328.html, 2011) 

 

2.3. Komponen Elektronika 

Komponen elektronika adalah komponen-komponen yang disusun  

membentuk suatu kesatuan rangkaian elektronika. Komponen ini yang 

digunakan untuk melakukan komunikasi antara perangkat satu dengan 

perangkat lainnya. Berikut akan diuraikan beberapa komponen elektronika 

yang digunakan dalam perakitan sistem pengendali kelistrikan alat 

penerangan ini. 

2.3.1. Resistor 

Resistor adalah komponen elektronika yang berfungsi menghambat arus 

dalam suatu rangkaian listrik. Resistor yang digunakan dalam elektronika 

dibagi dalam dua kategori utama, yaitu : 

1. Resistor linear adalah Resistor yang tidak tergantung kepada keadaan 

disekitarnya (nilainya tetap).  

2. Resistor nonlinear terdiri dari tiga jenis, yaitu :  

a. Fotoresistor : Peka terhadap sinar.  

b. Thermistor : Peka terhadap panas.  

c. Resistor yang tergantung pada tegangan listrik.  

Sifat-sifat resistor adalah : 

1. Jika pada ujung-ujungnya dipasang tegangan akan mengalir arus :  

2. Dapat mengalirkan arus searah maupun bolak-balik 

3. Dapat mengalirkan arus bolak-balik berfrekuensi tinggi. 

Simbol untuk resistor diperlihatkan pada gambar 2.2 dan unit satuannya 

adalah ohm (Ω). Satuan lain yang umum dipangkatkan tiga: 

Kilo ohm (𝑘Ω) = 1.000 ohm 

Mega ohm (𝑀Ω) =  1.000.000 ohm 
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Gambar 2.3 Simbol Resistor 

 

 

Gambar 2.4 Resistor 

 

Tabel 2.1 Kode Warna Resistor 

Warna Ukuran  Pengali Toleransi 

Hitam 0 1   

Coklat 1 10 ±1  

Merah 2 100  ±2  

Jingga 3 1000 - 

Kuning 4 10000 - 

Hijau 5 100000 - 

Biru 6 1000000 - 

Ungu 7 - - 

Abu-abu 8 - - 

Putih 9 -  - 

Emas  - 0.1  ±5  

Perak  - 0.01  ±10  

Polos  - -   ±20 
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2.3.2. LED (Light Emitting Diode) 

LED (Light Emitting Diode) atau diode pemancar cahaya adalah diode 

semikonduktor yang memancarkan cahaya jika dibias maju. Berbagai bahan 

telah digunakan dalam pembentukan bahan tipe-P dan tipe-N untuk 

sambungan diode. Salah satu pembuat alat ini menggunakan gallium arsenida 

dan gallium alumunium arsenida untuk bahan sambungannya. Sambungan 

yang dibuat dari bahan ini memancarkan cahaya infra merah. Bahan lain yang 

berbeda digunakan untuk memancarkan cahaya warna lain seperti hijau atau 

kuning.  

Jika LED dibias maju maka arus bias akan menyebabkan 

diinjeksikannya elektron ke dalam bahan tipe-P dan lubang diinjeksikan ke 

dalam bahan tipe-N. Dinyatakan dalam tingkat energi, elektron bebas berada 

pada tingkat yang lebih tinggi dari pada lubang. Jika elektron bebas bergerak 

melalui daerah dekat sambungan, mereka bergabung kembali dengan lubang. 

Dalam proses penggabungan kembali ini, energi dilepas, sebagian dalam 

bentuk cahaya sangat rendah, yakni kurang dari satu persen.  

Diode pemancar cahaya mempunyai beberapa keuntungan 

dibandingkan dengan sumber cahaya lain. LED bekerja pada tegangan rendah, 

sehingga sesuai dengan alat semikonduktor lainnya. Mereka mempunyai 

waktu respon yang sangat cepat, ukurannya kecil dan umurnya panjang. 

Keuntungan ini menyebabkan LED sesuai sekali khususnya untuk 

memperagakan informasi yang diperoleh dari peralatan elektronik. 

 

Gambar 2.5 Simbol LED 
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2.3.3. Transformator 

Transformmator atau trafo adalah komponen elektromagnet yang dapat 

mengubah taraf suatu tegangan AC ke taraf yang lain. Adaptor AC-DC 

merupakan piranti yang menggunakan transformator step-down. 

 

Gambar 2.6 Bentuk Fisik Resistor 

Transformator bekerja berdasarkan prinsip induksi elektromagnetik. 

Tegangan masukan bolak-balik yang membentangi primer menimbulkan fluks 

magnet yang idealnya semua bersambung dengan lilitan sekunder. Fluks 

bolak-balik ini menginduksikan GGL dalam lilitan sekunder. Jika efisiensi 

sempurna, semua daya pada lilitan primer akan dilimpahkan ke lilitan 

sekunder. 
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Gambar 2.7 Fluks Pada Transformator 

2.3.4. Kapasitor 

Kapasitor adalah komponen elektronika yang dapat menyimpan muatan 

listrik. Struktur sebuah kapasitor terbuat dari 2 buah plat metal yang dipisahkan 

oleh suatu bahan dielektrik. Bahan-bahan dielektrik yang umum dikenal 

misalnya udara vakum, keramik, gelas dan lain-lain. Jika kedua ujung plat 

metal diberi tegangan listrik, maka muatan-muatan positif akan mengumpul 

pada salah satu kaki elektroda metalnya dan pada saat yang sama muatan-

muatan negatif terkumpul pada ujung metal yang satu lagi. Muatan positif 

tidak dapat mengalir menuju ujung kutup negatif dan sebaliknya muatan 

negatif tidak bisa menuju ke ujung kutup positif karena terpisah oleh bahan 

elektrik yang non-konduktif. Muatan elektrik ini “tersimpan” selama tidak ada 

konduktif pada ujung- ujung kakinya.  

Di alam bebas fenomena kapasitor terjadi pada saat terkumpulnya 

muatan-muatan positif dan negatif diawan. Kondensator diidentikkan 

mempunyai dua kaki dan dua kutub yaitu positif dan negatif serta memiliki 

cairan elektrolit dan biasanya berbentuk tabung.Sedangkan jenis yang satunya 

lagi kebanyakan nilai kapasitasnya lebih rendah, tidak mempunyai kutub 

positif atau negatif pada kakinya, kebanyakan berbentuk bulat pipih berwarna 
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coklat, merah, hijau dan lainnya seperti tablet atau kancing baju yang sering 

disebut kapasitor (capacitor). 

 

 

Gambar 2.8 Bentuk Fisik Kapasitor 

Namun kebiasaan dan kondisi serta artikulasi bahasa setiap negara 

tergantung pada masyarakat yang lebih sering menyebutkannya. Kini 

kebiasaan orang tersebut hanya menyebutkan salah satu nama yang paling 

dominan digunakan atau lebih sering didengar. Pada masa kini, kondensator 

sering disebut kapasitor (capacitor) ataupun sebaliknya yang pada ilmu 

elektronika disingkat dengan huruf (C). Satuan dalam kondensator disebut 

Farad. Adapun cara memperluas kapasitor atau kondensator dengan jalan: 

1. Menyusunnya berlapis-lapis. 

2. Memperluas permukaan variabel. 

3. Memakai bahan dengan daya tembus besar 

Kapasitor merupakan komponen pasif elektronika yang sering dipakai di 

dalam merancang suatu sistem yang berfungsi untuk mengeblok arus DC, 

Filter, dan penyimpan energi listrik. Didalamnya 2 buah pelat elektroda yang 

saling berhadapan dan dipisahkan oleh sebuah insulator. Sedangkan bahan 

yang digunakan sebagai insulator dinamakan dielektrik. Ketika kapasitor 

diberikan tegangan DC maka energi listrik disimpan pada tiap elektrodanya. 

Selama kapasitor melakukan pengisian, arus mengalir. Aliran arus tersebut 
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akan berhenti bila kapasitor telah penuh. Yang membedakan tiap - tiap 

kapasitor adalah dielektriknya.  

 

2.3.5. Transistor 

Transistor adalah alat semikonduktor yang dipakai sebagai penguat, 

sebagai sirkuitpemutus dan penyambung (switching), stabilisasi tegangan, 

modulasi sinyal atau sebagai fungsi lainnya. Transistor dapat berfungsi 

semacam kran listrik, Diana berdasarkan arus inputnya (BJT) atau tegangan 

inputnya (FET), memungkinkan pengaliran listrik yang sangat akurat dari 

sirkuit sumber listriknya. 

Pada umumnya, transistor memiliki 3 terminal. Tegangan atau arus yang 

dipasang di satu terminalnya mengatur arus yang lebih besar yang melalui 2 

terminal lainnya. Transistor adalah komponen yang sangat penting dalam 

dunia elektronik modern. Dalam rangkaian analog, transistor digunakan dalam 

amplifier (penguat). Rangkaian analog melingkupi pengeras suara, sumber 

listrik stabil, dan penguat sinyal radio. Dalam rangkaian-rangkaian digital, 

transistor digunakan sebagai sakar berkecepatan tinggi. Beberapa transistor 

juga dapat dirangkai sedemikian rupa sehingga berfungsi sebagai logic gate, 

memori, dan komponen-komponen lainnya. 

Transistor adalah komponen elektronika yang mempunyai tiga buah 

terminal. Terminal itu disebut emitor, basis, dan kolektor. Transistor seakan-

akan dibentuk dari penggabungan dua buah dioda. Dioda satu dengan yang lain 

saling digabungkan dengan cara menyambungkan salah satu sisi dioda yang 

senama. Dengan cara penggabungan seperti dapat diperoleh dua buah dioda 

sehingga menghasilkan transistor NPN. 
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Bahan mentah yang digunakan untuk menghasilkan bahan N dan bahan 

P adalah silikon dan germanium. Oleh karena itu, dikatakan : 

1. Transistor germanium PNP 

2. Transistor silikon NPN 

3. Transistor silikon PNP 

4. Transistor germanium NPN 

Semua komponen di dalam rangkaian transistor dengan simbol. Anak 

panah 

yang terdapat di dalam simbol menunjukkan arah yang melalui transistor. 

 

Gambar 2.9 Symbol Transistor 

2.3.6. Dioda 

Dioda adalah suatu bahan yang dibuat dari bahan yang disebut PN 

Junction yaitu suatu bahan campuran yang terdiri dari bahan positif (P type) 

dan bahan negatif (N type). Apabila kedua bahan tersebut dipertemukan maka 

akan menjadi komponen aktif yang disebut Dioda. P type akan membentuk 

kaki yang disebut kaki Anoda dan N type akan membentuk Katoda. Pada 

dioda, arus listrik hanya akan dapat mengalir dari anoda ke kutub katoda. 
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Gambar 2.10 Simbol Dioda 

 

Sifat umum dioda adalah hanya dapat menghantarkan arus listrik ke satu 

arah saja. Oleh karena itu bila pemasangan dioda terbalik maka dioda tidak 

akan dapat menghantarkan arus listrik. Prinsip ini biasanya digunakan sebagai 

pengaman alat elektronika yaitu untuk menunjukkan benar atau salah 

penyambungan catu daya. 

Dioda memiliki dua elektroda (kaki), yaitu anoda dan katoda. Kaki – 

kaki ini tidak boleh terbalik dalam pemasangannya. Kaki katoda biasanya 

dekat dengan tanda cincin sedangkan kaki yang jauh dari tanda cincin berarti 

kaki anoda. Jika P (anoda) diberi tegangan positif dan N (katoda) diberi 

tegangan negatif maka pemberian tegangan ini disebut bias maju (biased 

forward). Sebaliknya, bila diberi tegangan yang terbalik yaitu P (anoda) diberi 

tegangan negatif dan N (katoda) diberi tegangan positif maka pemberian 

tegangan ini disebut bias mundur (biased reverse). Pada keadaan ini, arus yang 

mengalir dalam dioda sangat kecil sehingga dapat diabaikan. 

2.4. Relay 

Relay adalah suatu rangkaian switch magnetik yang bekerja bila 

mendapat catu dan suatu rangkaian trigger. Relay memiliki tegangan dan arus 

nominal yang harus dipenuhi output rangkaian pendriver atau pengemudinya. 

Arus yang digunakan pada rangkaian adalah arus DC. 
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Konstruksi dalam suatu relay terdiri dari lilitan kawat (coil) yang 

dililitkan pada inti besi lunak. Jika lilitan kawat mendapatkan aliran arus, inti 

besi lunak kontak menghasilkan medan magnet dan menarik switch kontak. 

Switch kontak mengalami gaya listrik magnet sehingga berpidah posisi ke 

kutub lain atau terlepas dari kutub asalnya. Keadaan ini akan bertahan selama 

arus mengalir pada kumparan relay. Dan relay akan kembali keposisi semula 

yaitu normaly ON atau Normaly OFF, bila tidak ada lagi arus yang mengalir 

padanya, posisi normal relay tergantung pada jenis rela yang digunakan. Dan 

pemakaian jenis relay tergantung pada kadaan yang diinginkan dalam suatu 

rangkaian. Menurut kerjanya relay dapat dibedakan menjadi : 

1. Normaly Open (NO), saklar akan tertutup bila dialiri arus 

2. Normaly Close (OFF), saklar akan terbuka bila dialiri arus 

3. Change Over (CO), relay ini mempunyai saklar tunggal yang nomalnya 

tertutup yang lama, bila kumparan 1 dialiri arus maka saklar akan 

terhubung ke terminal A, sebaliknya bula kumparan 2 dialiri arus maka 

saklar akan terhubung ke terminal B. 

Analogi rangkaian relay yang digunakan pada tugas akhir ini adalah saat basis 

transistor ini dialiri arus, maka transistor dalam keadaan tertutup yang dapat 

menghubungkan arus dari kolektor ke emiter yang mengakibatkan rela 

terhubung. Sedangkan fungsi dioda disini adalah untuk melindungi transistor 

dari tegangan induksi berlebih, dimana tegangan ini dapat merusak transistor. 

Jika transistor pada basis tidak ada arus maju, transistor terbuka sehingga arus 

tidak mengalir dari kolektor ke emiter, relay tidak bekerja karena tidak ada 

arus yang mengalir pada gulungan kawat. 
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2.5. Sensor Ultrasonik 

4Sensor ultrasonik ping adalah sensor 40 khz produksi parallax yang 

banyak digunakan untuk aplikasi atau kontes robot cerdas. Kelebihan sensor 

ini adalah hanya membutuhkan 1 sinyal ( SIG ) selain jalur 5 v dan ground. 

Perhatikan gambar dibawah ini : 

 

 

Gambar 2.11 Sensor Ultrasonik 

 

Sensor PING mendeteksi jarak objek dengan cara memancarkan 

gelombang ultrasonik ( 40 KHz ) selama t = 200 us kemudian mendeteksi 

pantulannya. Sensor PING memancarkan gelombang ultrasonik sesuai dengan 

kontrol dari mikrokontroller pengendali ( pulsa trigger dengan tout min 2 us ). 

Spesifikasi sensor ini : 

1. Kisaran pengukuran 3cm-3m. 

2. Input trigger –positive TTL pulse, 2uS min., 5uS tipikal. 

3. Echo hold off 750uS dari fall of trigger pulse. 

4. Delay before next measurement 200uS. 

5. Burst indicator LED menampilkan aktifitas sensor. 

 

                                                 
4 Tegar Assyidiqi Nugoro dkk, Kontrol Ketinggian Air pada Budidaya Ikan 

dan Tanaman Yumina Bumina Menggunakan Metode Fuzzy Takagi-Sugeno, 

Jurnal Pengembangan Teknologi Informasi dan Ilmu Komputer, Vol. 2, No. 7, 

Juli 2018, hlm. 2730-2737, Universitas Brawijaya. 
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2.6.  Turbidity Sensor 

5Merupakan Sensor yang digunakan untuk mengukur kualitas air, sensor 

ini mampu menentukan kualitas air yang keruh dan yang bersih. 

 

Gambar 2.12 Turbidity Sensor 

 

2.7.  Fuzzy Logic 

6Teori himpunan logika samar dikembangkan oleh Prof. Lofti Zadeh 

pada tahun 1965. Zadeh berpendapat bahwa logika benar dan salah dalam 

logika konvensional tidak dapat mengatasi masalah gradasi yang berada pada 

dunia nyata. Untuk mengatasi masalah gradasi yang tidak terhingga tersebut, 

Zadeh mengembangkan sebuah himpunan fuzzy. Tidak seperti logika boolean, 

logika fuzzy mempunyai nilai yang kontinue. Samar dinyatakan dalam derajat 

dari suatu keanggotaan dan derajat dari kebenaran. Oleh sebab itu sesuatu 

dapat dikatakan sebagian benar dan sebagian salah pada waktu yang sama. 

                                                 
5 https://www.dfrobot.com/wiki/index.php/Turbidity_sensor_SKU:_SEN0189 
6 Tegar Assyidiqi Nugoro dkk, Kontrol Ketinggian Air pada Budidaya Ikan 

dan Tanaman Yumina Bumina Menggunakan Metode Fuzzy Takagi-Sugeno, 

Jurnal Pengembangan Teknologi Informasi dan Ilmu Komputer, Vol. 2, No. 

7, Juli 2018, hlm. 2730-2737, Universitas Brawijaya. 
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2.7.1 Himpunan Fuzzy (Fuzzy Set) 

7Himpunan fuzzy (fuzzy set) adalah sekumpulan obyek x dimana masing-

masing obyek memiliki nilai keanggotaan (membership function) “μ” atau 

disebut juga dengan nilai kebenaran. Jika X adalah sekumpulan obyek dan 

anggotanya dinyatakan dengan x maka himpunan fuzzy dari A di dalam X 

adalah himpunan dengan sepasang anggota atau dapat dinyatakan dengan: 

𝐴 = {𝜇𝐴(𝑥)|𝑥: 𝑥 ∈ 𝑋. 𝐴(𝑥) ∈ [0,1] ∈ 𝑅} 

Terkadang kemiripan antara keanggotaan fuzzy dengan probabilitas 

menimbulkan kerancuan. Keduanya memiliki nilai pada interval [0,1]. Namun 

interpretasi nilainya sangat berbeda antara kasus-kasus tersebut. Keanggotaan 

fuzzy memberikan suatu ukuran terhadap pendapat atau keputusan, sedangkan 

probabilitas mengindikasikan proporsi terhadap keseringan suatu hasil bernilai 

benar dalam jangka panjang. Misalnya, jika nilai keanggotaan suatu himpunan 

fuzzy MUDA adalah 0,9 maka tidak perlu dipermasalahkan berapa seringnya 

nilai itu diulang secara individual untuk mengharapkan suatu hasil yang 

hampir muda. Dilain pihak, nilai probabilitas 0,9 muda berarti 10 % dari 

himpunan tersebut tidak muda (Kusumadewi & Purnomo, 2010). Himpunan 

fuzzy memiliki 2 atribut, yaitu :  

1. Linguistik, yaitu penamaan suatu grup yang memiliki suatu keadaan atau 

kondisi tertentu dengan menggunakan bahasa alami, seperti : MUDA, 

PAROBAYA, TUA.  

                                                 
7 Tegar Assyidiqi Nugoro dkk, Kontrol Ketinggian Air pada Budidaya Ikan 

dan Tanaman Yumina Bumina Menggunakan Metode Fuzzy Takagi-Sugeno, 

Jurnal Pengembangan Teknologi Informasi dan Ilmu Komputer, Vol. 2, No. 

7, Juli 2018, hlm. 2730-2737, Universitas Brawijaya. 
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2. Numeris, yaitu suatu nilai (angka) yang menunjukkan ukuran dari suatu 

variabel seperti : 5, 10, 15 dan sebagainya.  

Ada beberapa hal yang perlu diketahui dalam memahami sistem fuzzy, yaitu: 

1. Variabel fuzzy  

Variabel fuzzy merupakan variabel yang hendak dibahas dalam suatu 

sistem fuzzy. Contoh: umur, temperatur, permintaan, dan lain-lain.  

2. Himpunan fuzzy  

Himpunan fuzzy merupakan suatu grup yang memiliki suatu kondisi atau 

keadaan tertentu dalam suatu variabel fuzzy. Contoh: Variabel temperature 

terbagi menjadi 5 himpunan fuzzy, yaitu: dingin, sejuk, normal, hangat dan 

panas.  

3. Semesta Pembicaraan  

Semesta pembicaraan adalah keseluruhan nilai yang diperbolehkan untuk 

dioperasikan dalam suatu variabel fuzzy. Semesta pembicaraan merupakan 

himpunan bilangan real yang senantiasa naik (bertambah) secara monoton 

dari kiri ke kanan atau sebaliknya. Nilai semesta pembicaraan dapat berupa 

bilangan positif maupun negatif. Contoh semesta pembicaraan: 

a. Semesta pembicaraan untuk variabel umur: [0 +∞]  

b. Semesta pembicaraan untuk variabel temperatur: [0 40]  

 

4. Domain  

Domain himpunan fuzzy adalah keseluruhan nilai yang diizinkan dan boleh 

dioperasikan dalam suatu himpunan fuzzy. Semesti halnya semesta 

pembicaraan, domain merupakan himpunan bilangan real yang senantiasa 

naik (bertambah) secara monoton dari kiri ke kanan. Nilai domain dapat 

berupa bilangan positif maupun negatif. Contoh domain himpunan fuzzy: 

a. DINGIN = [0, 20]  
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b. SEJUK = [15, 25]  

c. NORMAL = [20, 30]  

d. HANGAT = [25, 35]  

e. PANAS = [30, 40]  

 

 

2.7.2 Jenis-Jenis Fungsi Keanggotaan  

Ada dua cara mendefinisikan keanggotaan himpunan fuzzy, yaitu secara 

numeris dan fungsional. Definisi numeris menyatakan fungsi derajat 

keanggotaan sebagai vektor jumlah yang tergantung pada tingkat diskretisasi. 

Misalnya, jumlah elemen diskret dalam semesta pembicaraan.  

Definisi fungsional menyatakan derajat keanggotaan sebagai batasan 

ekspresi analitis yang dapat dihitung. Standar atau ukuran tertentu pada fungsi 

keanggotaan secara umum berdasar atas semesta X bilangan real. Fungsi 

keanggotaan fuzzy yang sering digunakan antara lain: 

1. Fungsi Representasi Linear 

2. Fungsi Keanggotaan Segitiga 

3. Fungsi Keanggotaan Trapesium 

4. Representasi Kurva Bahu 

 

2.8.  Flowchart 

Suatu program yang baik adalah program yang bebas dari kesalahan dan 

menyusun sistematis agar prosesnya terlaksana secara efisien. Untuk itu 

sebelum menyusun program harus dipikirkan terlebih dahulu langkah 

penyelesaian dari masalah yang ada secara logis, sistematis, dan 

menggunakan metode, untuk menggambarkan urutan – urutan proses 
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digunakan data floe diagram yang disebut Flowchart. 

8Flowchart adalah sebuah jenis diagram yang mewakili algoritme, alir 

kerja atau proses, yang menampilkan langkah-langkah dalam bentuk simbol-

simbol grafis, dan urutannya dihubungkan dengan panah. Diagram ini 

mewakili ilustrasi atau penggambaran penyelesaian masalah. Diagram alir 

digunakan untuk menganalisa, mendesain, mendokumentasi atau 

memanajemen sebuah proses atau program di berbagai bidang.  

Simbol – simbol yang umum digunakan pada flowchart adalah sebagai 

berikut : 

 

Table 2.2 Simbol Flowchart 

Simbol Arti  

 Proses perhitungan / proses 

pengolahan data 

 Proses input, output data, parameter 

dan informasi 

 Proses inisialisasi / pemberian nilai 

awal (Persiapan data) 

 Menandakan dokumen yang di 

arsipkan (arsip manual) 

 Pepmulaan Sub program / proses 

menjalankan sub program  

                                                 
8 https://id.wikipedia.org/wiki/Diagram_alir , SEVOCAB: Software and 

Systems Engineering Vocabulary. Term: Flow chart. Retrieved 31 July 2008. 

https://id.wikipedia.org/wiki/Algoritme
https://id.wikipedia.org/wiki/Alir_kerja
https://id.wikipedia.org/wiki/Alir_kerja
https://id.wikipedia.org/wiki/Proses
http://pascal.computer.org/sev_display/index.action
http://pascal.computer.org/sev_display/index.action
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 Terminasi yang mewakili simbol 

tertentu untuk di gunakan pada aliran 

pada halaman lain.  

 Penghubung bagian – bagian 

flowchart simbol tertentu untuk di 

gunakan pada aliran yang berada pada 

halaman yang sama. 

 Terminasi menandakan awal dan 

akhir aliran. 

 
Pengambilan petutusan. 

 
Pemasukan data manual. 

 
Data penyimpanan ( disk storage ). 

 Arah aliran  program. 

 

2.9. Arduino Development Environment 

Arduino Development Environment terdiri dari editor teks untuk menulis 

kode, sebuah area pesan, sebuah konsol, sebuah toolbar dengan tomol-tombol 

untuk fungsi yang umum dan beberapa menu. Arduino Development 

Environment terhubung ke arduino board untuk meng-upload program dan 

juga untuk berkomunikasi dengan arduino board. 

Perangkat lunak yang ditulis menggunakan Arduino Development 

Environment disebut sketch. Sketch ditulis pada editor teks. Sketch disimpan 

dengan file berekstensi .ino. Area pesan memberikan memberikan informasi 
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dan pesan error ketika kita menyimpan atau membuka sketch. Konsol 

menampilkan output teks dari Arduino Development Environment dan juga 

menampilkan pesan error ketika kita mengkompile sketch. Pada sudut kanan 

bawah dari jendela Arduino Development Environment menunjukkan jenis 

board dan port seriak yang sedang digunakan. Tombol toolbar digunakan utuk 

mengecek dan mengupload sketch, membuat, membuka atau menyimpan 

sketch, dan menampilkan serial monitor. 

 

 

Gambar 2.13 Interface Arduino IDE 
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Dalam lingkungan arduino digunakan sebuah konsep yang disebut 

sketchbook, yaitu tempat standar untuk menumpan program (sketch). Sketch 

yang ada pada sketchbook dapat dibuka dari menu File > Sketchbook atau dari 

tombol open pada toolbar. Ketika pertama kali menjalankan arduino 

development environment, sebuah direktori akan dibuat secara otomatis untuk 

tempat penyimpana sketchbook. Kita dapat melihat atau mengganti lokasi dari 

direktori tersebut dari menu File > Preferences.  

Serial monitor menampilkan data serial yang sedang dikirim dari arduino 

board. Untuk mengirim data ke board, masukkan teks dan klik tombol send 

atau tekan enter pada keyboard. Sebelum meng-upload program, kita perlu 

mensetting jenis board dan port serial yang sedang kita gunakan melalui menu 

Tools > Board dan Tools > Serial Port. Pemilihan board berguna untuk 

mengeset parameter (contohnya: kecepatan mikrokontroler dan baud rate) 

yang digunakan ketika meng-compile dan meng-upload sketch.  

Setelah memilih board dan port serial yang tepat, tekan tombol upload 

pada toolbar atau pilih menu File > Upload. Arduino board akan me-reset 

secara otomatis dan proses upload akan dimulai. Pada kebanyakan board, LED 

RX dan TX akan berkedip ketika program sedang di-upload. Arduino 

Development environment akan menampilkan pesan ketika proses upload 

telah selesai, atau menampilkan pesan error. 

Ketika sedang meng-upload program, arduino bootloader sedang 

digunakan, Arduinp bootloader adalah sebuah program kecil yang telah 

ditanamkan pada mikrokontroler yang berada pada arduino board. Bootloader 

ini mengijinkan kita meng-upload program tanpa menggunakan perangkat 

keras tambahan. 
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BAB III  

METODE PENELITIAN 

 

3.1. Jenis Penelitian 

Jenis penelitian yang dilakukan untuk melengkapi data-data yang 

dibutuhkan serta perancangan alat adalah sebagai berikut: 

 

1. Studi literatur 

Pada tahap ini pengumpulan data dilakukan dengan mempelajari literatur 

yang berhubungan dengan perancangan alat dan komponen pendukung 

lainnya, pemahaman tentang logika fuzzy yang menjadi dasar teknologi 

untuk diterapkan pada sistem pengendali water level control untuk 

budidaya ikan gurame pada kolam terpal. 

 

2. Perancangan perangkat keras 

Rangkaian yang akan dirancang meliputi rangkaian sistem 

mikrokontroler, rangkaian pengendali sensor dan komponen lainnya pada 

alat yang akan dibuat. 

 

3. Perancangan perangkat lunak 
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Setelah perancangan perangkat keras yang meliputi sistem mikrokontroler 

dan sensor selesai maka akan dilakukan perancangan perangkat lunak 

yang terdiri dari diagram alir dan listing program. 

 

4. Pengujian alat 

Setelah perangkat keras dan perangkat lunak selesai dibuat, maka tahap 

berikutnya adalah pengujian alat. Jika hasil pengujian tidak sesuai dengan 

yang diharapkan, akan dilakukan perbaikan hingga tujuan utama dapat 

tercapai. 

 

3.2. Analisa Kebutuhan Sistem 

Pada tahap analisa kebutuhan sistem adalah dengan menganalisa 

kebutuhan informasi  fungsi sistem yaitu berupa proses – proses yang terjadi 

terhadap sistem dan kebutuhan non fungsi yaitu kebutuhan yang harus 

dipenuhi untuk perilaku sistem. Kebutuhan prilaku berkaitan dengan 

kebutuhan operasional, dan kinerja sistem. Untuk mendapatkan kebutuhan 

tersebut diperlukan teknik pengumpulan kebutuhan dengan wawancara, 

observasi dan analisis dokumen. 

3.3. Pemodelan dan Perancangan Sistem 

Perancangan yang dilakukan adalah dengan menggunakan pemodelan 

diagram flowchart untuk menunjukan kerja metode fuzzy dalam mengatur 

ketinggian dan kekeruhan air. 

 

3.4. Testing Prototype Sistem 

Pada tahap ini dilakukan testing terhadap sistem yang telah 

diimplementasikan menggunakan bahasa C dan tools Arduino Development 

Environment.Tahapan pengujian dimulai dengan menguji alat dan sistem. Hal 
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tersebut dilakukan berulang - ulang hingga alat dan sistem dapat berjalan 

dengan sempurna. 
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BAB IV 

HASIL DAN PEMBAHASAN 

 

 

4.1. Arsitektur Sistem 

 

Pada diagram blok pada gambar 3.1 merupakan gambar keseluruhan 

sistem pengatur ketinggian air menggunakan logika fuzzy yang menjelaskan 

tentang alur kerja keseluruhan sistem. 

 

 

 

 

 

 

 

 

 

 

Gambar 4.1 Arsitektur Sistem Water Level Control  
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4.2. Kebutuhan Alat 

 

Berikut ini merupakan kebutuhan alat yang akan digunakan pada sistem 

pengendali water level control. 

 

Tabel 4.1 Kebutuhan Alat 

No. Item 

1 Turbidity Sensor 

2 Ultrasonic Sensor 

3 DC Brushless Waterpump 12V 

4 Relay Module 1 Channel 5V 

5 WeMos NodeMCU ESP8266 

6 Box Case 

7 Wireless AP Outdoor 

8 Nylon Screw M3x6mm 

9 Nylon Nuts M3x6mm 

10 Power Supply 5V 3A 

11 Power Supply 12V 7A 

12 Kabel Jumper 20P (F-F) 

13 Kabel Jumper 20P (M-F) 

14 Kabel Jumper 20P (M-M) 

15 Selang PVC 11 mm 

16 Pipa 3/4" 

17 Elbow 3/4" Drat Dalam 

18 Socket 3/4" Drat Luar 

19 Socket 3/4" Drat Dalam 

20 Valve Solenoid 3/4" 
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21 Silicon Sealant 

22 Colokan Listrik 5 Lubang Phillips 

23 Box Container Lion Star  

24 Kabel Listrik 

25 DC Konektor (F) 

26 DC Konektor (M) 

27 Steker 

28 Solder 40W 

29 Sedot Timah 

30 Timah Solder 0.6 

31 Solder Flux 

32 Selotip Kabel Listrik 

 

 

4.3. Perancangan Fuzzy 

 

Perancangan sistem menggunakan metode fuzzy memperlukan beberapa 

tahap agar keputusan yang menjadi output dari sistem sesuai dengan 

perhitungan metode fuzzy. Tahap tersebut adalah fuzzifikasi, inferensi fuzzy 

dan defuzzifikasi. Pada gambar 4 menunjukkan bahwa tahapan pada kontrol 

fuzzy memiliki fungsi yang saling berhubungan dengan tahapan yang lain 

sehingga tahapan yang dihasilkan akan menjadi input dari tahapan berikutnya 

sampai menjadi output akhir dari sistem. Berikut ini adalah gambar 

perancangan sistem kerja alat menggunakan metode fuzzy 
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Start

Inisialisasi
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Gambar 4.2 Flowchart Kinerja Sistem Water Level Control 
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A
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Gambar 4.3 Lanjutan Flowchart Kinerja Sistem Water Level Control 

 

Adapun berdasarkan flowchart diatas cara kerja sistem pengendali water 

level control pada tahap awal mulai sistem bekerja terjadi proses inisialisasi 

dan sistem akan otomatis terhubung ke Access Point melalui Wireless AP 

Outdoor jika terhubung maka secara otomatis ultrasonic sensor dan turbidty 

sensor akan membaca kondisi alam dan mengecek kondisi air. Dalam hal ini 

maka metode fuzzy akan mengkondisikan proses sistem pada air, dimana jika 

air cukup dan air bersih maka ultrasonic sensor dan turbidty sensor akan 

membaca kondisi ketinggian dan kekeruhan air dan dalam kondisi ini maka 
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kran valve tidak akan terbuka. Jika kondisi air cukup dan air keruh maka secara 

otomatis kran valve akan terbuka dan membuang air yang ada dikolam hingga 

air yang tersisa dikolam tinggal 3 cm kemudian kran valve akan tertutup dan 

pompa air akan hidup secara otomatis dan air pada tangki akan mengalirkan 

air ke kolam ikan hingga ketinggian air mencapai 14 cm dan jika sudah sesuai 

maka pompa akan mati. Kemudian jika air kurang dan air bersih maka dengan 

otomatis pompa air pada tangka akan hidup dan secara otomatis akan 

mengalirkan air sampai mencapai batas maksimal air. Kemudian Jika air 

kurang dan air keruh maka secara otomatis kran valve akan terbuka dan 

membuang air yang ada dikolam hingga air yang tersisa dikolam tinggal 3 cm 

kemudian kran valve akan tertutup dan pompa air akan hidup secara otomatis 

dan air pada tangki akan mengalirkan air ke kolam ikan hingga ketinggian air 

mencapai 14 cm dan jika sudah sesuai maka pompa akan mati. 

Pada proses fuzzifikasi adalah proses pembuatan fungsi keanggotaan 

dari bilangan real. Keluarannya berupa variabel linguistik yang membedakan 

tiap kondisi yang ada berdasarkan nilai range. Variabel ketinggian air, 

memiliki 3 variabel linguistik yaitu: air rendah, air kurang, air tinggi, dan pada 

variabel untuk kualitas kekeruhan air terdapat 2 variabel linguistik yaitu: air 

bersih dan air keruh. Berikut ini adalah gambar variabel ketinggian air dan 

variabel kekeruhan air: 
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Gambar 4.4 Fungsi Keanggotaan Ketinggian Air 

 

 

Gambar 4.5 Fungsi Keanggotaan Kekeruhan Air 
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4.4. Hasil Penelitian 

Berikut ini adalah hasil penelitian yang dibuat dalam bentuk prototype 

Sistem Pengendali Water Level Control Untuk Budidaya Ikan Gurame Pada 

Kolam Terpal Menggunakan Logika Fuzzy Berbabis Mikrokontroler. 

 

Gambar 4.1 Perancangan Prototype Sistem Pengatur Ketinggian Air 
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Gambar 4.2 Persiapan Uji Coba  

 

 

 

Gambar 4.2 Prototype Tangki Air  
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Gambar 4.3 Prototype Kolam Ikan yang dilengkapi dengan Ultrasonik 

dan Turbidty Sensor 

Turbidity 

Sensor 

Ultrasonic 

Sensor 

Air Kolam 

Yang Keruh  

Arduino 

UNO 
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Gambar 4.4 Prototype Kolam Ikan Dilengkapi Keran Valve Untuk 

Membuang Air Keruh 

 



 

43 
 

 

Gambar 4.5 Uji Coba Alat 
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Gambar 4.6 Pengujian Sistem Pengendali Water Level Control Untuk 

Budidaya Ikan Gurame Pada Kolam Terpal Menggunakan Logika 

Fuzzy Berbasis Mikrokontroler  
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4.5. Analisis Sistem 

Untuk sistem kerja yang ada pada sistem pengendali water level control 

untuk budidaya ikan gurame pada kolam terpal menggunakan logika fuzzy 

berbasis mikrokontroler diatas adalah terdapat turbidty sensor yang bekerja 

dengan range 0 s/d 5 volt. Dimana jika kondisi air yang keruh berada pada 

<=3,5 volt maka air dianggap keruh, maka sistem akan membaca secara 

otomatis keadaan air dan air akan otomatis terbuang dan kemudian terisi 

dengan air yang bersih.  jika kondisi air berada >=3,5 volt maka dalam kondisi 

ini air masih dianggap bersih. Adapun air yang diukur ketinggiannya adalah 

14 cm dan apabila air tersebut keruh maka otomatis kran akan terbuka dan 

membuang air yang keruh tersebut hingga air yang tinggal di dalam bak kolam 

tinggal 3 cm ketinggiannya. 
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BAB V 

PENUTUP 

 

Kesimpulan 

 

Berdasarkan penelitian dan pembahasan yang di lakukan, dapat ditarik 

kesimpulan sebagai berikut :  

 

1. Sistem pengendali water level control dapat dilakukan dengan mekanisme 

sederhana seperti pada prototipe simulasi ini. Hal ini dapat dikembangkan 

menjadi sistem yang lebih baik lagi dimana dapat diterapkan langsung pada 

kolam ikan yang pastinya dengan adanya sistem pengawasan yang 

dilakukan secara otomatis dengan menggunakan mikrokontroler akan 

memudahkan pemilik kolam ikan dalam mengembangkan usahanya. 

 

2. Perancangan dan implementasi sistem yang dapat mengontrol ketinggian 

air memanfaatkan metode fuzzy pada kolam berdasarkan ketinggian air dan 

kondisi kekeruhan air berhasil dirancang dan diimplementasikan. Terbukti 

sistem mampu membaca ketinggian air, kekeruhan air dan megolah data 

tersebut menggunaan metode fuzzy. 

 

3. Pada proses perancangan sistem pengendali water level control turbidty 

sensor yang bekerja dengan range 0 s/d 5 volt. Dimana jika kondisi air yang 

keruh berada pada <=3,5 volt maka air dianggap keruh, maka sistem akan 

membaca secara otomatis keadaan air dan air akan otomatis terbuang dan 

kemudian terisi dengan air yang bersih.  jika kondisi air berada >=3,5 volt 

maka dalam kondisi ini air masih dianggap bersih. Adapun air yang diukur 
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ketinggiannya dengan menggunakan sensor ultrasonic adalah 14 cm dan 

apabila air tersebut keruh maka otomatis kran akan terbuka dan membuang 

air yang keruh tersebut hingga air yang tinggal di dalam bak kolam tinggal 

3 cm ketinggiannya. 
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CODE ARDUINO 

 

Excecutor : 

#include <SPI.h> 

#include <ESP8266WiFi.h> 

 

#define PUMP      4 

 

const char* ssid     = "nevleen"; 

const char* password = "15121213"; 

WiFiServer server(80); 

 

void setup() { 

  // put your setup code here, to run once: 

  Serial.begin(115200); 

  WiFi.begin(ssid,pass); 

  while(WiFi.status() != WL_CONNECTED) 

  { 

    Serial.print("."); 

    delay(500); 

  } 
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  server.begin(); 

 

  pinMode(PUMP,OUTPUT); 

} 

 

void loop() { 

  // put your main code here, to run repeatedly: 

  WiFiClient client = server.available(); 

  if(client) 

  { 

    if (client.connected()) 

    { 

      String request = client.readStringUntil('\r'); 

      client.flush(); 

      if (request == "Start") 

      { 

        Serial.println(request); 

        digitalWrite(PUMP, HIGH); 

      } 

      else if (request == "Stop") 

      { 

        Serial.println(request); 
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        digitalWrite(PUMP, LOW); 

      } 

      else 

      {11000m hhmmbbbvhhgx 

        Serial.println(request); 

      } 

    } 

    client.stop(); 

  } 

} 
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Explorer: 

 

:#include <SPI.h> 

#include <ESP8266WiFi.h> 

 

const char* ssid     = "SRIANI"; 

const char* password = "00000000"; 

 

long duration,distance,wLevel; 

float vTurbidity; 

int sensorHeight = 30; 

int minLevel = 2; 

int maxLevel = 14; 

  

#define TRIGGER_PIN  4 

#define ECHO_PIN     5 

#define VALVE        12 

#define TURBIDITY    A0 
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IPAddress server(192,168,0,9); 

WiFiClient client; 

 

void setup() { 

  // put your setup code here, to run once: 

  Serial.begin(115200); 

  pinMode(TRIGGER_PIN, OUTPUT); 

  pinMode(ECHO_PIN, INPUT); 

  pinMode(VALVE,OUTPUT); 

 

  WiFi.begin(ssid, password); 

  while (WiFi.status() != WL_CONNECTED) { 

    Serial.print("."); 

    delay(500); 

  } 

} 

 

void loop() { 

  // put your main code here, to run repeatedly: 

  // check_Connection(); 

  if (WiFi.status() != WL_CONNECTED) 

  { 



 

55 
 

    Serial.print("Terhubung ke : "); 

    Serial.println(ssid); 

    Serial.print("IP Address : "); 

    Serial.println(WiFi.localIP()); 

  } 

  //client.connect(server,80); 

   

  delay(1000); 

} 

 

void check_Connection(){ 

  if (WiFi.status() != WL_CONNECTED) 

  { 

    Serial.print("Terhubung ke : "); 

    Serial.println(ssid); 

    Serial.print("IP Address : "); 

    Serial.println(WiFi.localIP()); 

  } 

  else 

  { 

    Serial.println("Koneksi Terputus !"); 

    Serial.print("Mencoba menghubungkan ke : "); 
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    Serial.println(ssid); 

    WiFi.begin(ssid,password); 

    while (WiFi.status() != WL_CONNECTED) { 

      Serial.print("."); 

      delay(500); 

  } 

  } 

} 

 

void getWaterLevel(){ 

  digitalWrite(TRIGGER_PIN, LOW); 

  delayMicroseconds(2); 

  digitalWrite(TRIGGER_PIN, HIGH); 

  delayMicroseconds(10); 

  digitalWrite(TRIGGER_PIN, LOW); 

  duration = pulseIn(ECHO_PIN, HIGH); 

  distance = (duration/2) / 29.1; 

  wLevel = distance; 

  Serial.print("Water Level : "); 

  Serial.print(distance); 

  Serial.println(" cm"); 

  delay(1000); 
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} 

 

void getTurbidity() 

{ 

  vTurbidity = analogRead(A0)/1024.0*5.0; 

  Serial.print("Turbidity : "); 

  Serial.print(vTurbidity); 

  Serial.println(" V"); 

  delay(1000); 

} 

 

void openValve() 

{ 

  if (digitalRead(VALVE)== LOW) 

  { 

    digitalWrite(VALVE, HIGH); 

  } 

} 

 

void closeValve() 

{ 

  if (digitalRead(VALVE) == HIGH) 
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  { 

    digitalWrite(VALVE, LOW); 

  } 

} 

 

void waterSupply() 

{ 

  closeValve(); 

  if (wLevel < maxLevel) 

  { 

    streamData_Start(); 

  } 

  else 

  { 

    streamData_Stop(); 

  } 

} 

 

void waterDrain() 

{ 

  if (wLevel > minLevel) 

  { 
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    openValve(); 

  } 

  else 

  { 

    closeValve(); 

  } 

} 

 

void streamData_Start() 

{ 

  client.println("Start"); 

  delay(1000); 

} 

 

void streamData_Stop() 

{ 

  client.println("Stop"); 

  delay(1000); 

} 

 

 

 


